
Technical Tips for Windows 
Last-Minute Information

This document will be easiest to read if you maximize it, and can be printed if you
have a printer attached to your computer.
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Using Write to View This Document
To make this document easier to read, you can enlarge the Write window to its 
maximum size. To do so, click the Maximize button in the upper-right corner of 
the window. Or open the Control menu in the upper-left corner of the Write 
window (or press ALT+SPACEBAR), and then choose the Maximize command.

To move through the document, press PAGE UP or PAGE DOWN. Or click the 
arrows at the top and bottom of the scroll bar along the right side of the Write 
window.

To print the document, choose Print from the File menu.

For Help on using Write, press F1.

What Is This Document?
This document is intended to be a source of technical information and tips to help
you get your Windows-based Maxis product running. 

This document is NOT a replacement for the documentation for Windows, for you
computer, or for your video or sound cards. You should use those other docs as 
your primary source of information and as the final authority on how Windows, 
your computer or your cards work.



Warning! 
Some of the information in this document is very technical. Read it very carefully 
before you do anything to your computer. If you don't understand something, 
don't do it. It is possible to cause bigger problems than you're trying to solve if 
you aren't experienced--and careful.

With that in mind, read on!

Some Common Questions and Answers
What Are System Conflicts and What Can I Do About Them?
Conflicts are rare but they do occur. If you are using other programs in Windows 
that load on startup, you may want to disable those programs to prevent potential
conflicts and free up additional memory and system resources. The most 
common potential conflicts come from screen savers. If you are using a screen 
saver other than the default Windows screen saver, you may wish to disable it to 
prevent conflicts. Some virus protection programs may also cause conflicts. If 
you experience trouble running a Maxis product for Windows, try disabling virus 
protection programs.

The best way to determine if there is something else running in Windows is to 
press the Ctrl and Esc keys on your keyboard at the same time. This will bring 
up the Windows Task List:

The only item shown in the Task List window should be Program Manager. If 
there are any other items shown, and you want to disable them, simply click on 
the item to highlight it and press the End Task button to shut it off. If there are 
several programs running, hit Ctrl+Esc again, and follow the previous steps. Do 
this until only Program Manager is active, then close the Task List window. Now 
run your Maxis game.
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What Do I Do About Problems with Sound or Music?
Maxis products for Windows support all sound cards that are compatible with 
Windows 3.1. If you do not have a sound card, you will not hear sound effects or 
music.

If you do have a sound card, check the Options menu (if any) in your Maxis 
game. There may be two menu items in the Options menu called "Music" and 
"Sound." For music and sound effects to play, both menu items MUST be 
checked.

If you have a sound card and the "Music" and "Sound" menu items are both 
checked, but you cannot hear sound or music, your sound card or its Windows 
drivers may not be installed correctly for Windows. To check if your sound card is
installed properly, choose "Run" from the Program Manager's File menu. In the 
Command Line type "MPLAYER" as shown below:

"MPLAYER" is the command to run a Windows program called Media Player. 
Select the File option by clicking once with the mouse on the word File in the 
upper left of the Media Player window. Select Open and a list of available files 
will be displayed. Find the file called canyon.mid (in your Windows directory), 
click on it so that it is highlighted, then click on the OK button. You will now see 
the Media Player again, and the title bar will say "Media Player - CANYON.MID 
[stopped]." Click on the play arrow (the black triangle pointing to the right) to play 
the file. If you do not hear music, or if you get an error, your sound card is 
probably not installed properly. Please consult the documentation that came with 
your sound card or contact the manufacturer for assistance on correcting the 
problem, or see the next section about Sound Card Drivers.

Now, select the File option again. Select Open, and find the file tada.wav, and 
click on it so that it is highlighted, then click on the OK button. You will see Media 
Player again, but now the title bar will say "Media Player - TADA.WAV [stopped]." 
Again, click on the play arrow. If you do not hear a sound effect, or if you get an 
error, your sound card is probably not installed properly. Please consult the 
documentation that came with your sound card or contact the manufacturer for 
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assistance on correcting the problem, or see the next section about Sound Card 
Drivers.

What's the Deal With Sound Card Drivers?
Sound cards use drivers in Windows to play sounds. We take advantage of 
sound cards to play music and sounds via the Windows drivers that are installed 
for your sound card. If you are using a sound card and you experience lock-ups 
or General Protection Faults, your sound card drivers may be out of date and 
require a new version be installed. Below are some steps that you can take to 
determine if your sound card drivers need to be updated to the latest version.

1. Read ALL OF THE DIRECTIONS BELOW before you make any changes to 
your system.
2. Open the Main window located in the Program Manager.
3. Double-click on the Control Panel icon. (This will open the Control Panel 
window)
4. Double-click on the Drivers icon located within the Control Panel window.
5. Remove all drivers that make reference to MIDI and Wave. NOTE: Different 
sound cards have different names for their sound drivers. Most drivers do make 
reference to Wave or MIDI, though.
6. Restart Windows after your sound card drivers have been removed and run 
your Maxis game.
7. If the problem is corrected, you will need to obtain the latest version of your 
sound card drivers from your sound card's manufacturer. Please consult the 
documentation that came with your sound card for information on this.
8. If the problem persists, please refer to the Video Card Drivers section of this 
document.
9. To re-install the sound card drivers, consult the documentation that came with 
your sound card.

Video, Palettes and Pictures
What Are Video Drivers?
Windows uses a set of programs called Video Drivers to control how it accesses
your particular hardware to display things on the screen. Usually, the video card 
that you have installed in your machine will come with a set of video drivers that 
you can install for use with Windows. Windows comes with some video drivers 
that work on almost any video card and allow Windows to display 16 colors at a 
resolution of 640x480 pixels.

What does this have to do with your Maxis Game?
Most Maxis games are written for a 256-color environment (more colors!). Since 
many people may only have the generic 16-color video drivers installed or may 
have video drivers for more than 256 colors, we allow our games to run in color 
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resolutions other than 256. Obviously, trying to run a program with 256-color 
artwork in 16 colors is going to look downright yucky. Additionally, due to the way 
many high-color and true-color cards work, some animations may not work 
properly with systems running in more than 256 colors. However, in most cases, 
the games are still playable, so if you don't have 256-color drivers or are not sure
how to install them, you can still play the game while calling your video card 
manufacturer or reading up on the documentation that came with your video 
card. For absolutely best results, we recommend that you run our games on a 
system configured for exactly 256 colors.

The steps to change the type of video driver you are using are system-specific; 
you may well have an icon in your Control Panel or even a separate Program 
Group in Program Manager for setting and changing resolutions (screen size) 
and color depths (number of colors). We recommend that you check with your
vendor or manufacturer for information on your display card, but here are 
some general hints and tips we can run through:

Find and double-click the Windows Setup icon, usually located in the group 
Main. Check what you are set to for Display. If it's just "VGA", that means it has 
640x480 resolution (which is fine) but only 16 colors (which we need to change). 
To change, you will likely need your original Windows disks, so keep them handy.
Go to Options and choose Change System Settings. After clicking on the down
arrow on the far right end of the Display bar, you'll want to scroll up and down to 
see the available selections. We want one that lists specifically 256 colors. 
Important: Do not select the 'Video 7', 'XGA', or any other 256 color driver 
without making sure you have that type of adapter installed! Selecting the 
wrong video driver will result in an improper or unreadable Windows display. The
proper display driver is specific to your video hardware, and is supplied by your 
vendor or video card manufacturer.

Once you find the proper video driver, select that setting, click on OK and insert 
disks as requested. Let Windows restart itself (click on Restart Windows) and 
off you go. If the driver has already been installed, you may not need the disks 
and you can just select Current when prompted.

If you don't see the proper video drivers in the list of available drivers, then 
chances are the video card software is not installed on your system. Contact your
vendor or video card manufacturer to obtain the proper software for your video 
card. We cannot get 256 colors on a system without software from the video card
manufacturer.

An alternative...
If you have Windows for Workgroups 3.11, you should see the option for 
"SuperVGA"; make sure to select one that lists 256 colors. "SuperVGA (640x480,
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256 colors)" or "SuperVGA (800x600, 256 colors)" should be good choices. This 
is a generic Microsoft driver that works with many cards; although it isn't 
optimized for your card specifically, it should get you going. If you experience 
problems with it, we would recommend that you obtain a driver that is specific to 
your card from your dealer or the card's manufacturer. This Microsoft generic 
driver is available through many shareware dealers or from Microsoft.

It is possible that after Windows restarts with the new driver that your display will 
blank out or not function properly. This indicates that you will need a specific 
driver for your card, but here's how to put things back the way they were. At the 
C:\ prompt, go to the Windows directory (type CD\WINDOWS [Enter]) and then 
start the configuration program (SETUP [Enter]). Use the up arrow to highlight 
the display, then hit [Enter] and scroll down to VGA. Go back down to Accept 
these settings... and off you go. 

Nevertheless, this driver will do the trick in the majority of cases and get you up 
and running; certainly, if you have it, it's worth a whirl. 

You may also see a message from the Windows Graphics package, WinG. It 
runs a calibration test the first time it installs to optimize video performance. It 
may warn you that it is using a slower method of video due to "an older version" 
of your video card software; your game and WinG will run for now, but we would 
recommend obtaining an updated version of your display driver (one that is 
WinG-friendly) at your first convenience, from the dealer or manufacturer of your 
video card. For more information about WinG, keep reading...

A note about WinG 
Some Maxis games use some of Microsoft's newest video Extensions for better 
video performance and increased speed. Although these utilities allow for better 
performance, they can be a bugger to get working properly sometimes.

WinG will require 100% cooperation from your video card. The problems we have
are usually not related to the hardware (video card itself), but rather the software 
which comes with your video card. WinG is going to push your video card's 
capabilities to the limit. If the software which came with your video card is not up 
to Windows' full specification, you may get error messages, lock-ups, blank 
screens, or other graphical glitches.

Problems using WinG
WinG does its best to detect problems with video card software. If WinG 
anticipates any problems running on your system, it will give you a message 
which says it has encountered problems, and will not install on your system until 
the problem is corrected. Note: Even if WinG fails to install on your system, 
the program should still run fine. But it will run at a reduced rate because the 
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program will not run using WinG. In order to fix this problem and run the game 
using WinG, contact your vendor or video card manufacturer and have them
send you an update (Windows video drivers) for your system. This update 
must come from the video card manufacturer, and cannot be provided by Maxis 
or Microsoft. Specifically, the video drivers need to be "WinG compatible" in order
for WinG to operate without problems. Most video cards are shipped with 
software that is WinG compatible.

If the video card manufacturer is unable to provide you with software, or if the 
"newest" version of their software does not support WinG, then you may wish to 
use the generic Microsoft SuperVGA video drivers. Information about Microsoft's 
SuperVGA drivers are explained above under "An alternative...."

Video Card Drivers
Cirrus Logic Chipset
Certain older drivers shipped with Cirrus Logic video cards may be incompatible 
with Maxis games. Make sure you have the absolutely most recent versions of 
the video drivers for your card or use the Microsoft Generic SVGA drivers, 
available on most on-line systems or from Microsoft.

Diamond Stealth 64 DRAM/VRAM
>>Important! Really Important!<< If you have a Diamond Stealth 64 VRAM or 
DRAM video card, you need to disable all "Power Saver" features (even the 
DOS ones)! Otherwise, your system may inexplicably power off while the game 
is in the foreground.

Memory Issues
Overview of memory
Most Maxis games for Windows require that you run Windows in 386 Enhanced 
Mode (Microsoft calls it that whether you've got a 386, 486 or a Pentium). You 
can check to see if you are in Enhanced Mode by choosing Help in your Program
Manager, then going to About Program Manager.... If About Program Manager 
says you are in Standard Mode, exit Windows, then restart with the command 
WIN/3 [Enter] instead of WIN. This will force Windows to start in Enhanced 
Mode. If you cannot run Windows in Enhanced Mode, please verify that your 
system meets or exceeds the minimum system requirements printed on the 
system requirements label on the box that the game came in. 

Depending in the game (check the box or the Quick-Start Guide) it may require 
either 4 or 8 Megabytes (MB) of real RAM, and require at least a 2-4 Megabyte 
swap file in Windows. Under Windows, we prefer you to have about 8 MB free 
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(between both the real RAM and the swap file). Most computer systems with 4 
Megabytes of real RAM can have up to 10 or 12 MB free under Windows by 
using Virtual Memory (a swap file).

Virtual Memory and Win32s...
The newer Maxis games for Windows use a 32-bit Microsoft memory extension 
called Win32s. Win32s allows us to take advantage of the advanced processing 
nature of the 386, 486, and Pentium systems. Using Win32s will result in faster 
performance.

Win32s will automatically be installed on your system when you install the game. 
It is a Microsoft Extension for Windows, and will not interfere with the 
performance of your system.

Win32s requires a swap file (Virtual Memory) in Windows. This means that in 
addition to the RAM installed in your system, Windows must use a portion of your
hard-drive to "emulate" RAM. On a 4 MB system, you should be able to get about
10-12 MB of free memory in Windows. On an 8 MB system, it is possible to 
obtain over 20 MB of free memory.

A Windows swap file is required when using Win32s, regardless of how 
much RAM is installed on the system. This is due to the advanced 32-bit 
addressing which is performed by Win32s.

Win32s will alert you to any problems if it is unable to allocate virtual memory. If 
Windows is not set up for using a swap file, or if the current swap file has been 
corrupted, Win32s will prompt you to set up a swap file before running the 
application.

For more information about setting up a swap file under Windows, refer to 
your documentation for Microsoft Windows. If you're industrious, we have 
provided some information about setting up a swap file in the next section below.

If your computer doesn't have enough memory...
If you don't have enough memory available to run your Maxis game, first ensure 
that you close any other program that may be running to free up the necessary 
memory. If this doesn't correct the problem, consult your Windows manual and 
refer to the section entitled MEMORY. There are several different options 
explained within this area, from editing your startup configuration files to using 
virtual memory. Virtual memory actually uses your system's hard drive to 
temporarily store information that would normally be kept in the system RAM 
memory. With most Maxis games, a swap file will be required on your system.

WARNING!!
Maxis Technical Tips for Windows 8



DON'T USE VIRTUAL MEMORY IF YOU ARE USING DISK COMPRESSION! 
e.g. DoubleSpace/DriveSpace, Stacker, Super Stor, etc. Most of these programs 
will come with their own utilities to use virtual memory, so refer to the 
documentation that came with your compression program for more 
information.

You may run Virtual Memory by following these steps:

1. Open the Main window from within the Program Manager.
2. Double-click on the Control Panel icon. (This will open the Control Panel 
window.)
3. Double-click on the Enhanced icon (the icon looks like a computer chip -- if it is
not there, you are not running Windows in Enhanced Mode. See the instructions 
above on how to start Windows in Enhanced Mode).
4. Click on the Virtual Memory... button located on the right side of the window.
5. This will open the Virtual Memory window from which you can view the current 
virtual memory settings. You can increase the size by clicking on the Change 
button and increasing the size of virtual memory available on your system.
6. Please see your Windows manual for more information concerning virtual 
memory.

Finally, if you are using Sound and Music in your Maxis game for Windows, you 
will need as much free conventional memory as possible. Conventional memory 
is memory below 640K. Please see your DOS manual for instructions on freeing 
conventional memory.

Installing or running with Windows shells other than Program Manager
Shell programs are third party replacement programs that you can use in place of
the standard Windows Program Manager, such as HP Dashboard, the Norton 
Desktop, and XSoft's TabWorks (which comes installed on most Compaq 
computers). If you are having trouble installing or running a Maxis game for 
Windows, try either turning off the shell you are using, or using that program's 
File - Run command to run Program Manager. The command line to run Program
Manager is C:\WINDOWS\PROGMAN.EXE. Once you have installed the game, 
you should be able to close Program Manager and run the game through the 
shell program you usually run.

Some shell programs simply won't let you run our games properly. This will 
depend on which shell you are running. Once you have successfully installed the 
program, if you find that the game still won't run, try turning off the shell program 
you have been using.

A Special Note About TabWorks 
If you are running TabWorks, you might be able to eliminate any conflicts you are 
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having by going to the Options menu. Select File Tracking Options, and unselect 
(make sure there is no check mark) Track File Creation and Track File 
Modification. This will allow you to install the game through TabWorks without 
having to run Program Manager.

Error Messages / Troubleshooting
General troubleshooting
Before diving into the depths of what causes error messages, it is a good idea to 
make sure that we do our best to resolve conflicts before they occur. Anytime you
run more than one Windows application at the same time, you run the risk of 
encountering errors. To help solve and/or prevent errors, it is a good idea to shut 
down all other applications before running large programs (like our games).

If you get General Protection Faults, memory errors, blank screens, glitched 
graphics, sound glitches, or other problems, first disable all other applications 
that are not necessary to run your system. Follow the guidelines outlined above 
under the Some Common Questions and Answers section about System 
Conflicts. Windows is designed to operate several applications at the same time, 
but sometimes it burps a little. (You can't pull two carts with the same horse at 
the same time!)

WinG has encountered a problem...
WinG may detect problems with some video interfaces. If you see this message 
prompting you to contact your video card manufacturer, then do exactly that. 
Check with the people who sold you your video card (or the folks who made the 
video card) and have them send you updated software (video drivers) specifically
for your system. New software should be "WinG compatible" and better support 
Microsoft Windows. For more information, read the above section entitled Video, 
Palettes, and Pictures.

<something> caused a General Protection Fault...
General Protection Faults (GPFs) occur when the program is unable to perform a
specific operation. This operation may be anything from putting a dot on the 
screen to playing a sound effect. Windows is a collaboration of many different 
types of software working together; all from different manufacturers. Sometimes 
it's hard to get all of these different software products to agree in the same 
system.

Rarely are GPFs harmful to your system. In some cases, they will lock-up your 
computer, but they shouldn't destroy or corrupt anything. GPFs just warn you that
something couldn't be done because there's a problem with some of the software
on the system. Updating the "problem" software with a new version usually fixes 
these Faults.
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In order to identify what software is conflicting with the program, we try to 
interpret the error. The important part of the General Protection Fault is the 
Module that it reports. That tells us what part of your computer's memory 
crashed. Here are some of the important Modules, and what they usually mean:

KRNL386.EXE - A basic memory error occurred. This is usually due to a conflict 
with video or sound card drivers. Video and sound card manufacturers update 
their software as frequently as every other month. Contact the manufacturers and
obtain the latest version of software for your computer.

If you receive a General Protection Fault in Module KRNL386.EXE, and you've 
also had problems with WinG detecting errors, then you can almost bet that your 
video card software needs updating.

MM<whatever> or MCI<whatever> - The game is having problems with your 
sound card. If you are able to actually start the game, then try turning off the 
sound to see if this corrects the problem.

Follow the tests given above in the Common Questions and Answers section. 
Perform the tests for Music and Sound. If these tests fail, then most likely your 
sound card software is not properly installed. Refer to your sound card 
documentation or contact the vendor or sound card manufacturer for assistance 
with properly setting up your sound card's software.

If the tests pass okay, then you should probably contact the sound card vendor or
manufacturer for an updated version of your sound card software. Meanwhile, 
you can see if this will help:

From Program Manager, open up your Main group, then open up Control Panel. 
Inside the Control Panel, open up the Drivers section. In the list of drivers, find 
the one marked MCI [sound] and select it. Either double-click on MCI [sound] or 
click the Setup button. The sound buffer setting defaults to 4 seconds. Increase 
this to at least 8 or 10 seconds. Then click OK, close the Drivers Window, and 
restart Windows before running the game.

Again, if you still get errors after making sure the sound card software is fully 
installed, try to obtain an updated version of your sound card drivers from the 
vendor or sound card manufacturer.

256_1280.DRV or <whatever>.DRV - Usually you'll see numbers in this one, like
256_1280.DRV, W31-62B.DRV, or some other number/letter combination with 
a .DRV at the end. This is usually the video software. If you get this error along 
with problems reported by WinG, you can bet that your video card software 
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should be updated.

With errors like this, it is best to update your video card software. Contact the 
vendor or video card manufacturer and obtain the latest release of the video card
drivers for Windows. If you've already got the latest version, then you may wish 
to try the Microsoft SuperVGA drivers which may conform closer to Windows 
specifications. The Microsoft generic SVGA drivers are available through many 
shareware dealers or from Microsoft. You may wish to read the section above 
entitled An alternative... in the Video, Palettes, and Pictures section.

Win32s Error - ...Windows need to run with virtual memory enabled
Win32s requires that Windows runs with a swap file under virtual memory. At 
least a 2 MB swap file will be required, and a total of 8-10 MB should be free in 
Windows. For more information about setting up swap files and virtual memory, 
refer to your Windows documentation and/or your computer vendor. You may 
wish to read the sections above about Win32s and memory.

You will probably be asked to reinstall Win32s. Make changes to your Windows 
system following the suggestions above to enable virtual memory. Then reinstall 
the game. Installing the game will automatically install Win32s; there's no need to
separately install it.

How to Reach Maxis Customer Support
What To Do Before You Call Customer Support
Before you call Customer Support, please be sure that you have read this file 
and any other appropriate material first. When you are at your wit's end, 
scratching your head and grumbling, read on to find out what to have ready when
you call, so that we can get you up and running as quickly as possible. 

Note: Please make sure that your computer system meets or exceeds the 
requirements defined on the system label. The system label is located in the 
lower-left portion on the front of the box or on the spine of the box. If your 
computer doesn't meet these requirements, then there's nothing Maxis Customer
Support can do for you. Sorry.

What You Should Have With You When You Call
1. Have a printout of your WIN.INI and SYSTEM.INI files as well as your 
CONFIG.SYS and AUTOEXEC.BAT files. You can easily print all of these files by 
typing MSD [ENTER] at the C:\ prompt. This will run the Microsoft Diagnostics 
program which will allow you to print out a report of your system. If you can't print
out your system files (you don't have a printer), it isn't the end of the world, as 
long as you are at your computer when you call! 
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2. If you are getting error messages or General Protection Faults (GPFs), write 
down exactly what the error message says. That will help us diagnose the 
problem.

3. Write down all of the steps you have taken to solve the problem. If we know 
what you've already done, we may be able to get you running faster.

4. Have your program disks, your manual, and your Quick-Start Guide available 
and within easy reach.

Where You Should Be When You Call
Please, please call us from your computer! We need to have you at your 
computer to explore your system to identify what is causing your problem.

Let's Do the Numbers!
There are a number of different options that you can use to contact Customer 
Support. The best way to reach us is by e-mail, FAX, or telephone. If you decide 
that you would like to call and hear a friendly voice, you'll find the number for 
Customer Support listed on the Maxis Maxims sheet, included in the box your 
program came in. There's lots of other useful info there, so keep your Maxis 
Maxims somewhere handy.

We have established an automated Support service in addition to our live 
Support team. Automated Support is available 24 hours a day, 7 days a week. By
calling our Customer Support technical line, you may select automated Support 
in lieu of live assistance. Calling during non-Support hours will automatically 
prompt you for automated Support. Automated Support allows us to help you find
a solution quicker, and helps to reduce on-line waiting time.

We are present on all of the major on-line services and the Internet if you 
subscribe to any of these services. If you don't currently subscribe, many on-line 
services will give you a 30-day trial membership. Refer to the Maxis Maxims for 
more information.

If you have a modem, on-line support is often a better option for you. We 
maintain a BBS that is free-of-charge (excluding long distance charges from your
phone company) to all registered users of Maxis products. The BBS number is 
(510) 254-3869 and it is available 24 hours a day, 7 days a week. We support up 
to 14.4k bps and currently have four nodes. The settings are 8-N-1. You can also 
find the latest FAQs (Frequently Asked Questions), hints and tips from other 
users and other good stuff.

Fill in That Card!
Make sure you register your software! We've included a handy little postcard for 
Maxis Technical Tips for Windows 13



you to send in. This will entitle you to FREE Customer Support for the life of the 
product. The product life ends when a new version is released or the product is 
discontinued.

Introducing Maxis Customer Support...
And now what you've all been waiting for. Here's a little bit about the support 
staff: It just wouldn't be fair to give you all of this information without mentioning a
little bit about the guys in Customer Support. No, they didn't make or write the 
code and no, they didn't write the manual, but they do provide support for the 
product which far outlasts jelly doughnuts (and other comestibles).

Roger Johnsen (Customer Support Manager - Our Fearless Leader)
Aaron Shephard AKA Dr Emu

Kirk Lesser AKA Blud (like the stuff in your veins)
Chris Charman AKA Kwak

Owen Nelson AKA well, Owen (we still haven't given him a cute nickname yet)
Jeff Feil AKA Quam 

Rick "A Chief Apache" Acquistapace
Brian "Can you get me this driver..." Smith

Shannon "Not SHARON!" Dawes
Leo "Here 4 Ya" Kunkle II

Lisa "Now where did I file that..." Laverty

© 1995 Maxis, Inc.
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